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Copyrights and Trademarks

Copyrights and Trademarks

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical,
photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson printer. Epson is not responsible for any use of this information as applied to other printers.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses
incurred by the purchaser or third parties as a result of accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations
to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than
those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use of any interface
cables other than those designated as Epson Approved Products by Seiko Epson Corporation.

Microsoft and Windows are trademarks of the Microsoft group of companies.

Apple and Mac are trademarks of Apple Inc., registered in the U.S. and other countries.

Adobe, Acrobat, Illustrator and Reader are either registered trademarks or trademarks of Adobe in the United States and/or other countries.
General Notice: All other trademarks are the property of their respective owners and used for identification purposes only.

©2025 Seiko Epson Corporation
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Disclaimer

Disclaimer

Seiko Epson Corporation shall not be liable for any direct, indirect, or consequential damages arising from the use or inability to use this product
(including but not limited to damages to media caused by using this product or damages arising from works created using such media), or for any loss
of use or profits. This applies even if Seiko Epson Corporation has been advised of the possibility of such damages.
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Notes on Manuals

Meaning of Symbols

Important must be followed to
avoid damage to this product.

n Important:

Note: Notes contain useful or
additional information on the
operation of this product.

or Indicates related reference
content.

Screenshots used in this
manual

The screenshots may differ slightly from the screens
you are using. Also, they may be changed without
notice. Please be aware of this when using the manual.

Product Model
Descriptions

Some models described in this manual may not be
sold in your country or region.

Viewing PDF Manuals

This section uses the Adobe Reader DC as an example
to explain the basic operations for viewing the PDF
manual in Adobe Reader.
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@ Click to print the PDF manual.

@ Each time it is clicked the bookmarks are hidden
or shown.

© Click the title to open the relevant page.
Click [+] to open the titles lower in the hierarchy.

O If the reference is in blue text, click the blue text to
open the relevant page.

To return to the original page, do the following.

For Windows

While pressing the Alt key, press the < key.

For Mac

While pressing the command key, press the «
key.
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© You can enter and search for keywords, such as the
names of items you want to confirm.

For Windows

Right click on a page in the PDF manual and select
Find in the menu that is displayed to open the
search toolbar.

For Mac

Select Find in the Edit menu to open the search
toolbar.

O To enlarge text in the display that is too small to
see clearly, click @ Click @ to reduce the size.
To specify a part of an illustration or screenshot to
enlarge, do the following.

For Windows

Right click on the page in the PDF manual and
select Marquee Zoom in the menu that is
displayed. The pointer changes to a magnifying
glass, use it to specify the range of the place you
want to enlarge.

For Mac

Click View menu - Zoom - Marquee Zoom in this
order to change the pointer to a magnifying glass.
Use the pointer as a magnifying glass to specify the
range of the place you want to enlarge.

(7] Opens the previous page or next page.
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Overview of Braille
Printing

Note:

To access the Epson Edge Print PRO Operation Guide,
click the Help menu - Help from the main screen in
Epson Edge Print PRO.

If you are using a model that supports UV ink other
than the SC-V7000, you can print braille by printing
multiple layers of Varnish ink (hereafter called Vr).

The braille dot shapes formed are designed to comply
with JIS/ADA standards under specific conditions;
however, the printed results may not meet these
standards in some cases.

This guide explains how to create print data and print
jobs to create braille shapes that are equivalent to the
following standards.

[d JIS standard: Performance and test method of
ultraviolet ray hardening resinous braille (JIS
T9253)

[ ADA: Americans with Disabilities Act

For instructions on how to use models that support
UV ink, see the printer's User's Guide (online manual).

Items to Prepare

Use the following software to print braille using your
printer.

Adobe Illustrator

This is used to create print data for braille. You can
create job data for braille printing in Epson Edge Print
PRO by specifying spot colors for the parts to be
printed in braille.

Epson Edge Print PRO

This is the Windows RIP software that comes with
your printer. Use this when creating print jobs to send
to the printer from braille print data created in Adobe
Mlustrator.

For instructions on how to install the software, see the
Installation Guide (online manual). Also, for basic
operating procedures, see the Operation Guide.

Preparing the Operating
Environment

Check the following points.
(d The printer is turned on.

d The computer on which Epson Edge Print PRO is
installed is connected correctly to the printer.

[ Epson Edge Print PRO software version 7.0.0.0 or
later is installed.

[ The printer you are using is registered in Epson
Edge Print PRO.

Braille Printing Workflow

The following provides the workflow up to braille
printing.

Creating data for braille printing

Create braille print data in Adobe lllustrator.

£ "Creating Braille Print Data” on page 9

v

Creating the braille print job

Load the braille print data into Epson Edge Print PRO,
create a braille print job, and then send it to the printer.

£ “Creating a Braille Print Job” on page 10

v
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Printing

Printing starts when the job has been received.

£ “Starting Printing” on page 11

Precautions when
Performing Braille
Printing

In addition to the precautions listed in your printer's
User's Guide (online manual), note the following
points.

Use media that is 68.5 mm thick or less

If you use media that is thicker than 68.5 mm, you
cannot set the Media Gap (the distance between the
print head and the media surface) that is necessary for
printing braille using your printer. If the Media Gap is
not set correctly, the printer may malfunction during
printing.

We recommend using media that supports UV ink

Depending on the media you use, such as media that
does not support UV ink, the braille may not form a
dome shape, may spread out, or may peel off easily.

Set the printer's Media Gap to 2.0 mm

Before printing braille jobs, set the printer's Media
Gap to 2.0 mm. If the Media Gap is not set correctly,
the printer may malfunction during printing.

See your printer's User's Guide (online manual) for
details.
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Basic Braille Printing

When printing braille equivalent to the ADA
Diameter: 1.4 mm

This section explains how to create print data
containing only braille (without images or text) and
procedures for printing colorless braille.

Creating Braille Print
Data

This section explains how to create braille print data
using Adobe Illustrator 2024 as an example.

The procedure may differ depending on your version
of Adobe Illustrator.

Check the braille notation for the text you want
to print.

Example: When printing "EPSON" in braille

EPSON

Start Adobe Illustrator (hereafter called

Ilustrator) and create a new document.

A blank artboard is displayed.

Note:

The above diameters are recommended when
printing braille equivalent to JIS standards or the
ADA on an Epson printer that supports UV ink.
These differ from the dot diameters defined in JIS
standards or in the ADA.

Note:

You can print braille over images or text by
starting Illustrator and opening existing print
data.

£5° “Printing Braille Over Images or Text” on
page 12

Open the Ellipse Tool and create perfect circles
that will form the braille dots.

Create circles without outlines.

The diameter of the perfect circle varies
depending on the type of braille you are
printing.

(1 When printing braille equivalent to JIS
standards
Diameter: 1.3 mm

Arrange the perfect circles you created
according to the braille notation you checked in
step 1.

The spacing between dots varies depending on
the type of braille you are printing. Check the
dimensions carefully and then arrange
accordingly.

Note:
See the following for detailed dimensional
information for braille.

0 When printing braille equivalent to JIS
standards
JIS T9253:2004 appendix

0 When printing braille equivalent to the ADA
Chapter 7 of the 2010 ADA Standards for
Accessible Design
(Available on the ADA.gov website)
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Click Window - Swatches, and then click

(New Swatch).

Find xsensions on Exchange...

Pews Wi
proeen »
=

Werkspace

Exterdions

As shown below, specify the spot color name, as
well as the color to print from the screen in

Ilustrator.

O Swatch Name

Enter the following spot color name.
The following input is case sensitive.

Braille
@  Color Type
Select Spot Color.

® Color Mode

Select CMYK, and then specify the
color to print from the screen in
Mlustrator. Since white (all CMYK at
0%) can be difficult to distinguish from
the background color, we recommend
specifying another color that is easier to
distinguish. (Light blue is set in the
example image.) It is actually printed as

Vr.

Save the spot color you want to use for the
braille setting in Swatches, and then click OK.

Basic Braille Printing

10

New Swatch

Select all the perfect circles arranged in step 4,
and then specify the spot color for the braille
you saved to the Swatches in step 6.

When you are finished with the spot color
settings, save the data in PDF format.

Creating a Braille Print
Job

il

Start Epson Edge Print PRO and select the
printer you want to use for braille printing from
the switch printer tab on the main screen.

Click T (Add) on the job toolbar, and then

add the print data that includes the spot color
settings for braille.

Or, drag and drop the print data onto the Job

List.

The name of the data and a thumbnail for the
print data that was added appear in the Job List.
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Basic Braille Printing

Select the job for which you want to print
braille from the Job List.

An image of the printout appears in the preview
area.

Click := (Basic Settings) in the Job Setting
menu.

The setting area switches to Basic Settings.

Select General Braille in Media Name, and
then select the braille settings in Number and
Order of Layering.

Select one of the following according to the
type of braille you want to print, as in this
example, we are printing only braille without
any images or text.

[d  Single Layer (Braille Only - JIS)
4 Single Layer (Braille Only - ADA)

When you select the braille settings in Number
and Order of Layering, a Braille layer is added
under the layer in the image data from the Job
List.

4

Job List Printed Job

Job Name Status

Note:
See the following if General Braille is not
displayed in Media Name.

£ “When General Braille is not displayed in
Media Name in Epson Edge Print PRO” on
page 18

Check other settings and click (Print) on
the job toolbar.

The RIP process starts, and the braille print job
is sent to the printer.

11

Note:

When you click t=p (Print), the estimated time until
printing finishes is displayed at the top of the preview
area in Epson Edge Print PRO. Howevet, when printing
braille jobs, printing finishes sooner than the estimated
time displayed.

The following are the estimated printing times for each
model when printing one line of braille equivalent to the
ADA along the short edge of A4 size media (210
mm/8.3 in).

d  For SC-V1000 Series: approx. 11 minutes
[ For SC-V2000 Series: approx. 7 minutes

Starting Printing

n Important:

Before starting braille printing, check that the
Media Gap is set to 2.0 mm on the printer's
control panel screen. You can change the setting by
pressing the Media Gap area on the screen.

If the Media Gap is not set correctly, the printer
may malfunction during printing.

When the printer has received the job, & is
displayed at the bottom right of the screen.

Check that the media is loaded, and then press
the [@ area on the screen.

The braille layer is automatically printed

multiple times to achieve a height equivalent to

the braille standard selected in Number and

Order of Layering when creating the braille

print job.

After printing, measure the diameter and height of the
braille dots to check they have been printed at the
dimensions appropriate for the type of braille.

See the following if the braille has not been printed at
the appropriate dimensions for the type of braille.

£ “When You Want to Adjust the Size of the Printed
Braille” on page 19
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Various Braille Printing Methods

Various Braille
Printing Methods

Printing Braille Over
Images or Text

The following uses two examples to explain the
procedure for printing colorless braille over printed
images or text.

(4 When printing image or text data with braille data
in a single print job

(1  When printing image or text data with braille data
in separate print jobs

When Printing Image or Text
Data with Braille Datain a
Single Print Job

As shown in the following example, when combining
images or text with braille in a single print job, you
can complete printing the images or text and braille by
sending just one print job to the printer.

Example:

CAT

When you want to print simple print data as shown in
the illustration, we recommend combining it into a
single print job.

12

Notes on creating print data

Do not set spot colors for Vr printing in images or
text

Images or text with the Varnish spot color set for Vr
printing are recognized as braille by Epson Edge Print
PRO and will be printed in multiple layers at the same
height as the braille.

When you need to set spot colors for Vr printing for
images or text, create the image or text print data and
the braille data as separate print jobs.

£ “When Printing Image or Text Data with Braille
Data in Separate Print Jobs” on page 13

See the Epson Edge Print PRO Operation Guide for
details on spot colors for Vr printing.

Set Overprint Fill for the braille parts, and set the
stacking order to the front

When creating print data, set overprint for the braille
parts, and set the stacking order of objects so that they
are above (in front of) images or text. By setting
overprint for the braille parts, images or text that
overlap with the braille will also be printed.

The following shows the settings for Adobe Illustrator
2024.

1. Select all braille objects.

2. Click Window - Attributes to display the
Attributes panel, and then select Overprint Fill.

O A EO®IHNDRNTY Y ]
@ s

3. Click Object - Arrange - Bring to Front.
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See the following for more details on creating braille
print data.

£ “Creating Braille Print Data” on page 9

Notes on creating print jobs

Only a single color layer can be printed under
braille

Print data for images or text can only have a single
color layer. You cannot print White ink (hereafter
called WH) as a background for color.

When you need to print WH as a background for
color, create the image or text print data and the
braille data as separate print jobs.

£ “When Printing Image or Text Data with Braille
Data in Separate Print Jobs” on page 13

Select a double-layer setting in Number and Order
of Layering

When creating a print job in Epson Edge Print Pro,
select the following in the Job Settings menu - =
(Basic Settings).

[ Media Name
Select General Braille.

(d Number and Order of Layering
Select one of the following according to the type
of braille you want to print.
Double Layer (Color -> Braille - JIS)
Double Layer (Color -> Braille - ADA)

13

When you select a double-layer setting for braille in
Number and Order of Layering, a Color layer and a
Braille layer are added under the layer in the image
data from the Job List.

Job List Printed Job

Job Name Status

Since the Color layer is the same as for a normal
image or text print job, you can change the output
color using B= (Color Replacement). See the Epson
Edge Print PRO Operation Guide for details.

When Printing Image or Text
Data with Braille Data in
Separate Print Jobs

As shown in the following example, when creating and
printing image or text print data with braille data in
separate print jobs, you can perform multi-layer
printing for the image and text print job.

Example:

PrintJob A

First Layer: Print WH over the entire surface as a
background for the color (a)

Second Layer: Print images or text in color (b)
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Various Braille Printing Methods

Third Layer: Print Vr on top of the image (c) Print Jobs A +B

(d  With this printing method, the print job for
images or text (Print Job A) is the same as a
normal print job, so you can perform multi-layer
printing. You can set spot colors for Vr printing

. on images or text, or print WH as a background

Print Job B for the color. You can also add up to 10 layers

Print braille only. using the multi-layer printing function in Epson
Edge Print PRO.

See the Epson Edge Print PRO Operation Guide
for details on multi-layer printing.

[d  See the following for details on creating a
braille-only print job (Print Job B).
£ “Creating a Braille Print Job” on page 10

g Important:

Before starting braille printing after printing

images and text, set the Media Gap to 2.0 mm on
the printer's control panel screen. You can change
the setting by pressing the Media Gap area on the

screen.
When you run Print Job A and then Print Job B, Ifthe Media Q“P isn _Ot set ‘cor‘rectly, the printer
braille is printed on top of the multi-layer images or may malfunction during printing.

text.

Printing Color Braille

You can print color braille by creating an object that
serves as the background for the braille dots when
creating the print data and print the background in
any color.

14
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Creating Color Braille Print Data

This section explains how to create color braille print
data using Adobe Illustrator 2024 as an example.

The procedure may differ depending on your version
of Adobe Illustrator.

See steps 1 to 7 below to create print data for
braille with spot colors set for the braille.
£ “Creating Braille Print Data” on page 9

x ff  FHle Edit Objec

EPSON_Braille.ai* @ 200 % [CMYK/Preview) X

[N

I XX ..

FENNEHOIHANOGR Y

L.n‘

Q,

Select all of the objects created in step 1 and
copy & paste them onto the artboard.

Fill the copied objects with a color of your
choice.

The background of the braille dots is printed in
the color you set, making the braille appear
colored.

15

When setting a spot color as the fill, do not set
the spot color named "Braille".

Select all of the braille print data created in step
1 (the objects to be copied) and set Overprint
Fill.

Click Window - Attributes to display the
Attributes panel, and then select Overprint Fill
to apply the settings.

.
I’ 3
#

. . L] . T
. .. ] .
s —
T
a '] (X3 . o .e
* L ] . L] .
i
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Select all of the destination objects from step 3
and position them so that they overlap perfectly
with the braille data from step 4, and then set
their stacking order to be below (behind) the
braille data.

To set the stacking order, click Object -
Arrange - Send to Back.

[

OSSRy v

HP®OAN

N
>
I 4

|‘" \‘

HP2eIHANO

The following shows the stacking order of the
objects.

- A
- B

A: Braille print data (with spot color set for the
braille)

B: Braille background (with fill color of your
choice)

E Save the data in PDF format.

16

Creating a Color Braille Print
Job

n Start Epson Edge Print PRO and select the
printer you want to use for braille printing from
the switch printer tab on the main screen.

Click T (Add) on the job toolbar to add the
color braille print data.
Or, drag and drop the print data onto the Job
List.

The name of the data and a thumbnail for the
print data that was added appear in the Job List.

Select the job for which you want to print
braille from the Job List.

An image of the printout appears in the preview
area.

n Click = (Basic Settings) in the Job Setting

menu.

The setting area switches to Basic Settings.

5 Select General Braille in Media Name, and
then select the double-layer setting in Number
and Order of Layering.

Select one of the following according to the
type of braille you want to print.

(4 Double Layer (Color -> Braille - JIS)
d Double Layer (Color -> Braille - ADA)

When you select a double-layer setting for
braille in Number and Order of Layering, a
Color layer and a Braille layer are added under
the layer in the image data from the Job List.

“ Job List Printed Job

Job Name Status

EPSON_Color_Braille.pdf  Idle

. First Layer [Color]
. Second Layer [Braille]

Since the Color layer is the same as for a
normal image or text print job, you can change
the output color as needed using §= (Color
Replacement). See the Epson Edge Print PRO
Operation Guide for details.
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E Check other settings and click (Print) on
the job toolbar.

The RIP process starts, and the color braille
print job is sent to the printer.

17
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Troubleshooting &
Tips

When General Braille is
not displayed in Media
Name in Epson Edge Print
PRO

If the software version of Epson Edge Print PRO
installed on your computer is earlier than 7.0.0.0, you
need to update it to version 7.0.0.0 or later.

£ “Updating Epson Edge Print PRO” on page 18
Also, when using Epson Edge Print PRO version
7.0.0.0 or later, you need to re-register the printer in

Epson Edge Print PRO.

5 “Re-registering the Printer” on page 18

Note:
You can check the software version of Epson Edge Print
PRO by clicking the Help menu - Version.

Updating Epson Edge Print PRO
Click Download in Epson Edge Print

Installer / Updater on the download site
(https://support.epson.net/eep/) for Epson Edge
Print PRO, and then save the file to any
location on your computer.

Download the Model Information File for
your printer model by clicking Download, and
save the Model Information File to any location
on your computer.

Close Epson Edge Print PRO.

18

Unzip the file saved in step 1, and then
double-click EEPSetup.exe to start the
installation.

Follow the on-screen instructions to complete
the installation.

Note:

You do not need to uninstall the version of Epson
Edge Print PRO that you were using. It is updated
when you install and overwrite with the latest
software.

Unzip the Model Information File you saved in
step 2, and then double-click Model
Information File (.exe) to start the installation.

Follow the on-screen instructions to complete
the installation.

See the following section and re-register the printer in
Epson Edge Print PRO with the updated model
information.

Re-registering the Printer

By unregistering a printer, all the following content
related to work done previously on the printer is
deleted.

[d Job data for Job List or Printed Job lists

d  Acquired and added print information

[d  Added Quick Sets

If you want to use the above content after
re-registering the printer, save (Export) the necessary
data to a file in advance. See the Epson Edge Print
PRO Operation Guide for details.

il

Start Epson Edge Print PRO, and then click the
Tool menu - Preferences - iz (Printer).

Select the printer to unregister in the list, and
then click [ji] (Unregister).

Or, open the right click menu on the icon of the
printer to unregister and select Unregister.


https://support.epson.net/eep/
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When the confirmation message appears, click
Yes.

The printer that was registered with the model
information before the update is deleted.

Click -} (Register).

A list of connected printers that are not
registered in Epson Edge Print PRO is
displayed.

Select the printer you want from the list.

The name shown in Printer Name is displayed
on the printer switching tab of the main screen
as the name of the printer registered in Epson
Edge Print PRO. Change the name as necessary.

Click Register.

When You Want to Adjust
the Size of the Printed
Braille

Depending on the media you use, even if you create
braille print data and print the braille by following the
procedures in this guide, it may be printed at
dimensions that differ from the appropriate
dimensions for the type of braille you are printing.

Note:
See the following for detailed dimensional information
for braille.

d  When printing braille equivalent to JIS standards
JIS T9253:2004 appendix

1  When printing braille equivalent to the ADA
Chapter 7 of the 2010 ADA Standards for
Accessible Design

(Available on the ADA.gov website)

If the braille is not printed at the appropriate
dimensions for the type of braille, adjust the diameter
of the perfect circles when creating the braille print
data in Illustrator.

£ “Creating Braille Print Data” on page 9

19

After adjusting the diameter of the perfect circles,
print on your media and check the dimensions of the
braille.

When Images or Text
Overlapping with Braille
are Not Printed/When
Colored Braille has No
Color

If the following issues occur in your braille print
results, it is because Overprint Fill has not been set
for the braille parts when creating the braille print
data in Illustrator.

(4 When printing image or text print data with
braille data in a single print job, images or text
that overlap with braille are not printed.

(d  When printing a color braille print job, the color

set for the braille background is not printed.

When creating print data, select all of the braille
objects and select Overprint Fill in the Attributes
panel. See the following for details.

£ “Notes on creating print data” on page 12

5 “Creating Color Braille Print Data” on page 15
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